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Age Verification Feature 

Overview 

Sale of age-restricted items (i.e. alcohol & tobacco items) can be controlled at the point of sale by forcing to 
operator to enter a date of birth before a controlled item can be registered. Different age restrictions may apply to 
different items (i.e. alcohol may be allowed at age 21 and tobacco may be allowed at age 18).  

Registering age restricted items alerts the cashier with an error tone and the prompt “Need Age Verification” 
displays. The cashier must enter the birth date of the customer before allowing the sale of the age restricted item. 
The Birth-Date entered must be higher than the age required for the sale of the age restricted item. This birth date 
entry will apply to all item registered in the current sale. If the customer is 18 years old, they may be able to 
purchase cigarette items but would not be allowed to purchase alcohol items. If the customer attempts to purchase 
items that have a higher age restriction than the birth date already entered an error tone will sound and the prompt 
“Need Age Verification” pops-up again.   

Many state driver’s licenses have the driver’s data encoded on a magnetic stripe on the back of the license or on a 
barcode or QR code. When birth date entry is required, the driver’s license can be swiped or scanned at the ECR to 
verify the customer’s age.  

Sam4POS has four different age verification formats available for reading the Birth-Date from the magnetic stripe 
on the customer driver’s license by swiping on the MCR on the ECR. You will need to program the format specific 
for your application as necessary, any age verification formats that are not utilized in your area may be deleted.  

 

Note: The age verification feature is completely different than the RACS\JUUL feature that uses DL parsing 
to send the Birthdate to the POS. See RACS\JUUL Feature on page 12 of this application guide.  

 

Equipment Required 

The specific equipment necessary to perform age verification operations will vary depending on the Method used. 
Refer to the age verification chapters for Age Verification –  MCR on page 4 or Age Verification – Scanner on 
page 8 as required.  

Age Verification – MCR  
MCR SAPPHIRE-A60/A70 

 Item #: 503330 MCR Track 1, 2 & 3 (Standard)  
 Item #: 101539 MCR Connector Cover (If MCR is Not Installed)  

MCR SAP-630/530 
 Item #: 520051 – Optional, need to order separately.  

MCR SAP-6600II/6600 
 Item # 503133 – Comes standard with terminal.   

Age Verification – Scanner 
CODE 950 USB SCANNER  

 Item #: 110404-U – 1D\2D Barcode Scanner   



4  Age Verification – MCR  Sam4POS Age Verification v1.10 

Age Verification – MCR 

Many state drivers’ licenses encode the driver’s identification information on a mag stripe on the license. When 
age entry is required, the driver’s license can be swiped at the Sam4POS station using an integrated MCR for the 
age verification. This feature is enabled by identifying the appropriate track data on the license for the setting on 
the Age Verification program screen.   

There are four age verification formats available in the SAM4POS. Program the format specifically for your 
application as necessary. You can delete any age verification formats in the list that are not utilized in your area, 
formats can be added back if necessary.   

Operate by swiping the driver’s license or State ID (or manually entering the date) when the CUSTOMER DATE 
OF BIRTH window displays.  

 

Programming Required:   
 General Option → Enable Card Read 

 PLU → PLU Status Group & PLU programming 

 Device → Card Read Format → Age Verification  

 
Optional Programming: 

 General Option → Do Not Allow Manually Entered Age Verification Date  

 Print Option → Print Age Verified Message Instead Of Date Of Birth  

 

Equipment Required:  
MCR SAPPHIRE-A60/A70 

 Item #: 503330 MCR Track 1, 2 & 3 (Standard)  
 Item #: 101539 MCR Connector Cover (If MCR is Not Installed)  

MCR SAP-630/530 
 Item #: 520051 – Optional, need to order MCR separately.  

MCR SAP-6600II/6600 

 Item # 503133 – Comes standard with terminal.   

 

Note: On SAP-4800 Terminals, Be sure the “MSR Setting” programming (Refer to the Sam4POS Programming 
Manual  for details) is correct prior to programming the Age Verification.  

Note: When deciding the START number in the Column of Number, do not include the Sentinel Character and 
any characters (i.e. =  ,  ;  ,  %) that may appear within the data line.  
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Options 

Only the options related to Age Verification are shown here. Refer the Sam4POS Programming Manual for the 
complete list of all options & definitions.  

 

General Option  
The General Option to enable the card reader must be selected to be able to use the MCR for age verification.  

Go to:  Program Mode → Options → Options → General Option  

 
ETC 

ENABLE CARD READ  
This option must be checked to allow the integrated card reader (MCR) to be used for swiping a state 
issued  ID \ Driver’s License for age verification.   

Sale 
DO NOT ALLOW MANUALLY ENTERED AGE VERIFICATION DATE (ADDED IN V2.0.162) 

Optionally, we can select this option to disable the ability to manually enter a B-Date.  
When the Need Age Verification dialog displays, if you attempt to type in a birthdate, the error message 
MUST SCAN OR SWIPE displays. Only scanning or swiping of a license or ID is allowed.  

 

Print Option 
Optionally, you can edit the display to show the date of birth or the Age Verified message.  

Go to: Program Mode → Options → Options → Print Option  

 
Receipt & Journal 

PRINT AGE VERIFIED MESSAGE INSTEAD OF DATE OF BIRTH 
When selected, AGE VERIFIED will print on receipts and display on the register screen instead of the 
customer Birth Date.  
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Device 

Go to:  Program Mode → Device → Card Read Format → Age Verification 

Card Read Format – Age Verification – MCR 
The Card Read Format programming determines the card data (on Drivers Licenses or State issued ID cards with 
magnetic strip on the card) that will be utilized when the using the MCR for Age Verification.  There are four age 
verification formats available in the SAM4POS.  

 DDMMYYYY 
 MMDDYYYY 
 MMYYYYY99DD 
 YYYYMMDD 

Program the format specific for your application as necessary or add additional formats as necessary, any age 
verification formats that are not utilized in your area may be deleted.  

1. Select CARD READ FORMAT from the DEVICE menu. The selection screen below displays: 

   
2. Swipe the Driver’s License or State Issued ID Card to view the data on the card.  

 
3. Select the appropriate Age Verification format in the left-hand column:  

 Age Verification – Four age verification card types are available. Program the format specific for 
your application as necessary.  

4. Set the parameters for the card format type you selected.  
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Card Read Format Settings 

Card Data 
PLEASE SWIPE YOUR CARD! 

Swipe the Drivers License or state issued ID Card to view data – Card data is displayed so you can set the 
Format settings accoridingly. Count from the left to the reight to where the age stats.  

Read 
READ 

READ – Choose which track has the birthdate information; Track1, Track2, or Track3. 
Column Of Number 

COLUMN OF NUMBER –  
START – Enter the column number where the birthdate Starts on the Drivers License or state issued ID 
Card.  (Ignoring any sentinel character.)  

Date 
DATE 

The date format selected is displayed; Example: YYYYMMDD  

 

PLU Programming 

To set up age verification, you will need to create separate PLU Status Groups for each different age restricted 
product type and create PLU’s for each different age restricted product.   

  For Example: Age 18, Age 21, Age 65 (tobacco items, liquor items, etc.).    

 

PLU Status Group 
You will need to create separate PLU Status Groups for each different age restricted product type (liquor items, 
tobacco items, etc.).   

Go to:  PROGRAM MODE → PLU → PLU STATUS GROUP   
General 

NEED AGE VERIFICATION 
Enter the age required to purchase this age restricted product (example: 18 or 21). You will need a separate PLU 
Status Group for each age requirement. (Example: 18, 21, 65, etc.) 
When a PLU is registered that is assigned to one of these PLU Status Groups, the operator will be forced to 
enter a date of birth that indicates an age higher than the age as specified in the age verification setting.  
 

PLU 
Create all your PLU Items that require age verification as necessary and assign the appropriate PLU Status Group 
to those age restricted items.  

Go to:  PROGRAM MODE → PLU → PLU   
General 

PLU STATUS GROUP LINK 
Assign the age verification PLU Status Group to PLU’s that require age verification.  
NOTE: The GOTO button allows you to go to the programming options for that PLU status group.  
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Age Verification – Scanner 

Many state drivers’ licenses encode the driver’s identification information on a barcode or QR code. When age 
entry is required, the driver’s license can be scanned to verify the customer satisfies the age restriction set for the 
purchase of the age restricted item.  

The Sam4POS terminals can scan driver’s Licenses using either serial or USB scanners for age verification without 
very much setup at the terminal.  

 

Required Programming:   
 PLU Status Group & PLU programming.  
 Device Setting & Mapping (for serial scanners).  

USB scanners require no setup in Sam4POS.  
However, some scanners, such as CODE scanners, may require additional setup for use on Sam4POS.  

 
Optional Programming: 

 General Option → Do Not Allow Manually Entered Age Verification Date  
 Print Option → Print Age Verified Message Instead Of Date Of Birth  

 

NOTE: Our testing indicated that no additional setup or add-on DL Parsing file was necessary on Sam4POS to use 
the basic Age Verification with the scanners listed below.  

 

Any scanner would work such as:   
 CR950 – Can Integrate with Sam4POS.  

o Item #: 110404-U     (USB)  
o Item #: 110404-S     (Serial – No power supply)  
o Item #: 110404-SP   (Serial – With power supply)  

 CR5215 – Can be used as a standalone scanner for Age Verification; would need to disable standalone age 
verification to integrate with Sam4POS. Uses the same configuration codes as the CR950 scanner.  

o Item #: 110405-U     (USB)  
o Item #: 110405-SP   (Serial – With power supply)  

 CR5025 – Can be used as a standalone scanner for Age Verification; would need to disable standalone age 
verification to integrate with Sam4POS.   

o Item #: 110403-U     (USB)  
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Scanner Notes: 

CODE scanners are image scanners; they take a picture and process it. Image scanners may be slower since they 
are processing an image. You will need to scan the setup codes for the scanner for it to work properly with 
Sam4POS. When the initial setup codes have been scanned, the Code scanners will work for basic age verification 
with no additional configuration necessary.  

 One thing to inform the user is that they need to pull the trigger and wait…it may take several seconds to 
respond. A common mistake cashiers make is that if it doesn’t register right away they pull the trigger 
again.  Each time the trigger is pulled, the process starts over.  

If you want to use a different model scanner, it must have the ability to scan a 2D barcode and have the driver 
licenses parsing feature.  The dealer will need to figure out how to program the scanner to send just the birthday to 
the Sam4POS when the Driver’s license is scanned.  

 

Note: The age verification feature is completely different than the JUUL feature that uses DL parsing to 
send the Birthdate to the POS.  For use with the RACS\JUUL feature you will need to use a USB scanner 
and purchase the DL Parsing code. The QR code for DL Parsing is specific to the scanner serial number.  

See RACS\JUUL Feature on page 21 of this application guide.  

 

Options 

Only the options related to Scanning for Age Verification are shown here. Refer the Sam4POS Programming 
Manual for the complete list of all options & definitions.  

 

General Option  
Go to:  Program Mode → Options → Options → General Option  

 
Sale 

DO NOT ALLOW MANUALLY ENTERED AGE VERIFICATION DATE (ADDED IN V2.0.162) 
Optional setting, select this option to disable the ability to manually enter a B-Date.  
When the Need Age Verification dialog displays, if you attempt to type in a birthdate, the error message 
MUST SCAN OR SWIPE displays. Only scanning or swiping of a license or ID is allowed.  

 

Print Option 
If desired, you can edit the display to show the date of birth or the Age Verified message.  

Go to: Program Mode → Options → Options → Print Option  

 
Receipt & Journal 

PRINT AGE VERIFIED MESSAGE INSTEAD OF DATE OF BIRTH 
Optional setting: When selected, AGE VERIFIED will print on receipts and display on the register screen 
instead of the customer’s Birth Date.  
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Device 

Serial scanners require the device port settings be programmed to match the scanner settings and the scanner will 
need to be mapped to the station. USB scanners connected to the terminal would not require any port 
programming; Simply plug in the USB scanner.  

Important: Some scanners (such as Code scanners) may require specific scanner setup to operate with Sam4POS.  

The standard age verification feature will accept scanned data when the prompt for enter birthdate is displayed. The 
scanner needs to be configured to send the birthdate. (Requires v2.0.15 or later.)  

Go to:  Program Mode → Device → Device → Device Setting 

 

Device Setting Serial Scanner 
General 

DEVICE MODEL  
General Scanner 

COMMUNICATION TYPE 
Serial 

Serial 

COM PORT 
COM1 thru COM4 
/dev/tty/USB0 – only available when USB to RS-232 converter is connected to the terminal 

BAUD RATE 
1200, 2400, 9600, 19200, 38400, 57600, 115200 

STOP BIT 
1 or 2 

DATA BITS 
7 or 8 

FLOW CONTROL 
NONE, XON_XOFF (SW), RTS_DTS (HW) 

PARITY 
NONE, EVEN, ODD 

 

 

Device Mapping 
Map the Scanner to the Station: PROGRAM MODE → DEVICE → DEVICE MAPPING  

Input Description: Type a description for the device (up to 30- characters).  
Select Device: From the list of available devices as set in the Device Setting screens.  
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PLU Programming 

To set up age verification, you will need to create separate PLU Status Groups for each different age restricted 
product type and create PLU’s for each different age restricted product.   

  For Example: Age 18, Age 21, Age 65 (tobacco items, liquor items, etc.).    

 

PLU Status Group 
You will need to create separate PLU Status Groups for each different age restricted product type (liquor items, 
tobacco items, etc.).   

Go to:  PROGRAM MODE → PLU → PLU STATUS GROUP   
General 

NEED AGE VERIFICATION 
Enter the age required to purchase this age restricted product (example: 18 or 21). You will need a separate PLU 
Status Group for each age requirement. (Example: 18, 21, 65, etc.) 
When a PLU is registered that is assigned to one of these PLU Status Groups, the operator will be forced to 
enter a date of birth that indicates an age higher than the age as specified in the age verification setting.  
 

PLU 
Create all your PLU Items that require age verification as necessary and assign the appropriate PLU Status Group 
to those age restricted items.  

Go to:  PROGRAM MODE → PLU → PLU   
General 

PLU STATUS GROUP LINK 
Assign the age verification PLU Status Group to PLU’s that require age verification.  
NOTE: The GOTO button allows you to go to the programming options for that PLU status group.  
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Age Verification Operation 

Registering age restricted items alerts the cashier with an error tone and the “Need Age Verification” dialog 
displays. The cashier must enter the birth date of the customer using the keypad on the notification dialog before 
allowing the sale of the age restricted item. The Birth-Date that is entered must be higher than the age restriction 
set for the sale of the age restricted item. This birth date entry will apply to all item registered in the current sale.  

For example: If the customer is 18 years old, they may be able to purchase cigarette items but would not be 
allowed to purchase alcohol items requiring the customer to be age 21 or older. If the customer attempts to 
purchase items that have a higher age restriction than the birth date already entered, an error tone will sound and 
the “Need Age Verification” notification dialog pops-up again.   

Many state driver’s licenses have the driver’s data encoded on a magnetic stripe on the back of the license or on a 
barcode or QR code. When birth date entry is required, the driver’s license can be swiped or scanned at the ECR to 
verify the customer’s age.  

Operate by Swiping the driver’s license or State ID using the MCR or scanning the driver’s license or ID when the 
NEED AGE VERIFICATION dialog displays.  

 

1. Register an age restricted item is registered into a sale. The Need Age Verification dialog displays.  

 

2. When the Need Age Verification dialog appears,  
 Key in the customers birthdate in the Proper format.   
 Scan or Swipe the customers Driver’s License or State issued ID. 
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Age Verification Bypass MACRO 

Overview 

For customers that are obviously over 21, Sam4POS has the ability to use an Age-Bypass Macro that employees 
can press which will enter the age verification procedure automatically. Separate macros can be created if different 
age restrictions apply for various age restricted items. The macro will require a PLU to be setup to for each age 
restriction required (18, 21, 65, etc.) for your application.  

 

 

NOTES:  
 It is not recommended to use an Age Verification MACRO to bypass the age restriction 

operation in live installations! This gives any employee the ability to bypass the age 
restriction\verification requirement which completely nullifies the age verification feature.  

 You Cannot use an Age Verification MACRO if the General Option: Do Not Allow Manually 
Entered Age Verification is selected.   

 The birth date entry for each age verification MACRO must be edited every day to be 
accurate!  

 An age verification MACRO CANNOT be used with RACS\JUUL or with BandyWorks!  

 
Programming Required 

 PLU 
o PLU Status Group – for each Age Restriction 
o PLU – for each Age Restriction\Verification age 

 MACRO – for each Age Restriction Bypass Operation  

 

Optional Programming 
 HASH Options 
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PLU Programming 

To set up an age verification bypass Macro, you will need to create separate PLU Status Groups for each Age 
Verification PLU and for each different age restricted product type, then create PLUs for each of the desired age 
restrictions. For Example: Age 18, Age 21, Age 65 (tobacco items, liquor items, etc.).    

 

PLU Status Group 
You will need to create separate PLU Status Groups for each Age Verification Bypass PLU and for each different 
age restricted product type.   For Example: Age 18, Age 21, Age 65 (tobacco items, liquor items, etc.).     

 

Age Verification-Bypass PLU – PLU Status Group 

1. From the main Program Mode menu select PLU, select PLU Status Group from the menu selections to 
access PLU Status Group programming.  

2. Enter a DESCRIPTION for the age restricted PLU Status Group, and enter the age required to purchase 
this item in the NEED AGE VERIFICATION setting. Additional Settings:  

a. Set the PLU Status Group as HASH (so it doesn’t add to PLU & sales totals).  
b. Uncheck all PLU Print options: Print on Receipt, Journal, Guest Check, etc.  
c. Uncheck the ETC option: Display On Register Screen. 

“Age 21 PLU Status Group:” Need Age Verification = 21  
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Age Restricted Items – PLU Status Group 

The setup for your Age Restricted Items PLU Status Groups is the same as for the Age Verification PLU Status 
Groups except that you will check the Print & Display settings and set it to display on the register screen.  

1. From the main Program Mode menu select PLU, select PLU Status Group from the menu selections to 
access PLU Status Group programming.  

2. Enter a DESCRIPTION for the PLU Status Group to be used with your age restricted items, and enter the 
age required to purchase this item in the NEED AGE VERIFICATION setting. Additional Setting:  

a. Uncheck the HASH ITEM setting so these items add to PLU & sales totals.  
b. Check all PLU PRINT options: Print Receipt, Journal, Print on Guest Check, etc.  
c. Check the ETC option: Display On Register Screen.   

“Liquor PLU Status Group:” Need Age Verification = 21  
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Age Verification PLU Status Groups Examples 

Age Verification Bypass PLU - PLU Status Group Age Restricted Items - PLU Status Group 
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PLU 
Create separate PLUs for each of the desired age restriction\verification bypass items: For example: Tobacco 
items, Liquor items, etc.) Note: You Cannot use an age verification MACRO with the RACS\JUUL feature!   

Age Verification PLU 

1. From the main Program Mode menu, select PLU to view the PLU menu selections, then select PLU 
again to access PLU programming.  

2. Press the Add record  icon to Add\Create an Age 21 PLU to be used with the age verification bypass 
MACRO.  
a. Assign the PLU Status Group used for Age Verification to this new Age 21 PLU. For this example, 

we used the PLU Status Group “Age 21 Verification” which has the age restriction set for age 21.  
b. Set the Price Option setting as Preset (No Override) or as Preset (Allow Override).  

 

Age Restricted PLU’s 

3. Create all your PLU Items that require age verification as necessary and assign the appropriate PLU Status 
Group to those age restricted items.  
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Options 

Go to:  Program Mode → Options → Options  

General Option  
 
Sale 

DO NOT ALLOW MANUALLY ENTERED AGE VERIFICATION DATE (ADDED IN V2.0.162) 
You cannot use this setting when using a MACRO to enter a customer’s birth date.  

 

Print Option 
If desired, you can edit the display to show the date of birth or the Age Verified message.  

 

Receipt & Journal 
PRINT AGE VERIFIED MESSAGE INSTEAD OF DATE OF BIRTH 

Optional setting: When selected, AGE VERIFIED will print on receipts and display on the register screen 
instead of the customer’s Birth Date.  

 

HASH Option 
For the Age Verification PLU, we would typically leave all the HASH Option selections Unchecked.  

 

HASH 
UPDATES SALE (RECEIPT) TOTAL 

For the Age Verification PLU, we would leave all 
the HASH Option selections Unchecked.  

ADDS TO GROSS SALE TOTAL 
ADDS TO NET SALE TOTAL 
UPDATES HASH TTL ON FINAN/SFT RPT 
UPDATES TIME PERIOD REPORT 
UPDATES GROUP REPORT 
UPDATES INDIVIDUAL PLU TOTALS 
ADDS TO OVERALL PLU TOTALS 
UPDATES DRAWER TOTALS REPORT  
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MACRO 

Separate macros can be created if different age restrictions apply for various age restricted items. The macro 
will require a PLU to be setup to for each age restriction required (18, 21, 65, etc.) for your application.  
 

Bypass Age-Verification MACRO 
Create a MACRO to bypass the Age Restriction\Verification. A Pop-Up option is available for each line in a 
MACRO:  

 POP-UP = Y (checked) is used if you want the keystroke to be entered in a POP-UP box.  
 

 

NOTES:  
 It is not recommended to use an Age Verification MACRO to bypass the age restriction 

operation in live installations! This gives any employee the ability to bypass the age 
restriction\verification requirement which completely nullifies the age verification feature.  

 The birth date entry for each age verification MACRO must be edited every day to be accurate!  
 You Cannot use an Age Verification MACRO if the General Option: Do Not Allow Manually Entered 

Age Verification is selected.   
 An age verification MACRO CANNOT be used with RACS\JUUL or with BandyWorks!  

 
1. Select FUNCTION KEY from the main PROGRAM MODE menu screen; select MACRO KEY from 

the function key menu selections.   
2. Add a new Age 21 MACRO for the age verification bypass.  
3. Enter the keystrokes for the Age 21 MACRO:  

a. Age 21 PLU  
b. Enter each of the Numeric Values for the Birth-Date entry.  

 Check the POP-UP selection for each entry.  The birthdate entry depends on the setting from: 
Program Mode → PLU → PLU Status Group: NEED AGE VERIFICATION setting.   

c. Add the ENTER function key for the last keystroke; check the POP-UP selection..  
4. When all the MACRO keystrokes are all entered, it will appear as shown below. The POP-UP option will 

be selected for the Birth-Date numeric entries and the ENTER key, but not for the Age 21 PLU.  

  
5. Assign the Age 21 MACRO to an MLU or FLU.  
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Bypass Age-Verification MACRO Operation 
Typically, when an item requiring age verification is registered, the Age Verification dialog displays; The cashier 
would need to type in the B-Date to continue the sale. To bypass the requirement for Birth-Date entry, you would 
need to press the Age 21 MACRO prior to registering your age restricted items.  

 

 

NOTES:  
 It is not recommended to use an Age Verification MACRO to bypass the age restriction 

operation in live installations! This gives any employee the ability to bypass the age 
restriction\verification requirement which completely nullifies the age verification feature.  

 You Cannot use an Age Verification MACRO if the General Option: Do Not Allow Manually Entered 
Age Verification is selected.   

 The birth date entry for each age verification MACRO must be edited every day to be accurate!  
 An age verification MACRO CANNOT be used with RACS\JUUL or with BandyWorks!  

 

1. When an item is presented for purchase that requires Age Verification, if the cashier wishes to bypass the 
Birth-Date entry the cashier must press the Age 21 MACRO before registering the age restricted item.  

 

2. The Age 21 PLU is registered and the birthdate as in the Macro is entered.  
 Note: The Customer Date Of Birth scrolls across the top of the transaction detail window.  

3. Register the Age Restricted Item as presented for purchase.  
 Note: In this example the Age 21 PLU is set to print on receipts and display on the register screen 

for demonstration purposes. These settings can be set to Not Print and Not Display if desired in 
the PLU Status Group for age restriction.   
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RACS\JUUL Feature 

Overview 

Retail Access Control Standards (RACS) are a set of guidelines set forth by JUUL Labs that enables retailers to 
enforce age restrictions at point of-sale (POS) for RACS\JUUL products. RACS\JUUL has a plan to stop selling 
their products to stores that do not have a RACS compliant system.  

Learn more here: Documentation – RACS (racscompliance.org)  

JUUL Labs is partnering with retailers to support adoption of the Retail Access Control Standards (RACS) 
program, a technologically based solution to prevent youth access. These standards automate the transaction from 
beginning-to-end to ensure RACS\JUUL products are sold to verified legal-aged purchasers. Whenever a 
transaction contains RACS\JUUL products, a RACS-compliant point-of-sale POS system will require I.D. 
scanning to verify age and I.D. validity; limit the amount of product that can be purchased; and prevent manual 
override by the retail clerk. 

RACS-certified retailers must use a RACS-compliant POS system. RACS-compliant POS systems have software 
features that detect RACS\JUUL products scanned during a transaction and ensure transactions cannot be 
completed unless the above criteria are met. The RACS\JUUL feature added to Sam4POS is designed to meet the 
RACS\JUUL standards.  

A video showing the programming & operation for the RACS\JUUL feature with Sam4POS can be viewed here:  

https://www.youtube.com/watch?v=4jdYewNtIOE&list=PLtF-h-a37jHmbhGgLO3nB76hP-avFSW29&index=27  

 

There is no difference using the RACS\JUUL Feature with Sam4POS on any off the Sam4POS model terminals.  
 Sapphire A60 / A70 
 SAP-6600II / SAP-6600  
 SAP-630 / SAP-530  
 HM616 / HM626 
 SAP-4800II  

 

 

 
You CANNOT use an age verification MACRO with the RACS\JUUL feature!  
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Equipment Required 

To be able to scan a barcode on a driver’s license or state ID card for age verification, you must use a scanner that 
has the ability to scan a 2D barcode with DL Parsing capability. DL/ID Parsing Library DL/ID cards are widely 
used for storing personal information such as first name, last name, birth date, address, etc.  

For use with the RACS\JUUL feature you will need to purchase a USB scanner with the DL Parsing code.  

NOTE: The QR code for loading the DL Parsing file is specific to the scanner serial number. CRS recommends 
using a CODE USB scanner.  

 

 CODE CR950 – Can Integrate with Sam4POS  
CRS offers the CR950 scanner preconfigured with Driver License Parsing  

Item#: 110404–SAM4POS (CR950 USB for Sam4pos Software with DL Parsing pre-loaded.)  
Other Code CR950 scanners available are: 

Item#: 110404-U – USB scanner without DL Parsing file  
 

 CODE CR5215 – Standalone Age Verification - Must use USB CR5215 with Sam4pos 
Item #: 110405-U – USB scanner without power supply or DL Parsing file  

To Use the CR5215 For the RACS\JUUL feature, a DL Parsing is needed: 
Item#: 110410 – DL Parsing For Code Scanners  
 

 CODE CR5025 – For use as a standalone scanner for Age Verification (not integrated with Sam4pos) 
Item#: 110403-U – USB scanner without DL Parsing file  

 

If you choose to use a different model scanner, it must have the ability to scan a 2D barcode and will need to have 
the driver licenses parsing feature. Dealers will need to figure out how to program the scanner to send just the 
birthday to the Sam4POS when the Driver’s license is scanned.  
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Code Scanner - Scan Codes 

Code CR950 

CRS offers the CR950 scanner preconfigured with Driver License Parsing  
 Item#: 110404 – SAM4POS (CR950 USB for Sam4pos Software with DL Parsing pre-loaded.)    

Our testing indicated that no additional setup or add-on DL Parsing file was needed for the operations below. 

Other Code CR950 scanners available are: 
 Item#: 110404-U – USB scanner without DL Parsing file  

 

If necessary, you can Download & Install the latest firmware version from Code’s website and flash the firmware.  

https://www.codecorp.com/products/code-reader-950  

Code-950 USB 

Scan the initial setup codes to get scanner to work with Sam4POS to just sell / scan items.  

 Suffix Enter   

 USB Speed Full  

    

 
 
Sam4pos Testing 

Add New Scanned PLU Item – *Successful* (Rapid Scans)  
Ring Up Age Verification Item – Scan Test ID – *Successful* (4 Seconds to Populate Data)  
Ring Up JUUL Item – Scan Test ID – *Successful* (3 Seconds to Populate Data)  
Pull Up Customer Database – Scan Test ID – *Successful* (3 Seconds to Populate Data)  
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CR950 - Version 3 

The CR950 version 3 (indicated on the label) can be configured for either USB or Serial. The USB and Serial 
cables can be swapped and the appropriate configuration codes scanned to change the comm settings. Any versions 
prior to 3, would not be able to support both. The CR950 version 3 SKU should be: CR950-K303 to support both 
USB and RS232.  

NOTE: For Sam4POS Age Verification, JUUL, BandyWorks use the CR950 USB interface scanner.  

 Reset to Factory Defaults 

 Scan the appropriate codes to setup as USB or Serial 

 

Reset Scanner: 

  

 

Setup as USB: 
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Code CR5020 

Currently, CRS does not offer the CR5000 series scanners with the DL Parsing file included. If necessary, you 
may purchase the Driver License Parsing for CODE Scanners at the same time the scanner is purchased:   

 Item #: 110410 – Driver License Parsing for Code Scanners 
 

Our testing indicated that no additional setup or add-on DL Parsing file was needed for the scanners listed 
below.  

CRS currently has the CR5000 series scanner, model 5020: 
 Item #: 110401-U – USB   
 Item #: 110401-S – Serial (No Power Supply) 
 Item #: 110401-SP – Serial (with Power Supply)  

 

If necessary, you can Download & Install the latest firmware version from Code’s website and flash the firmware.  

https://www.codecorp.com/products/code-reader-5000  
 Scan the initial setup codes to get scanner to work with Sam4POS to just sell / scan items.  
 Reset to Factory Default   
 Suffix Enter   
 USB Speed Full 

 

   

 

Our testing indicated that no additional setup or add-on DL Parsing file was needed for the operations below. 

 

Sam4pos Testing: 
Add New Scanned Item – *Successful* (Rapid Scans) 
Ring Up Age Verification Item – Scan Test ID – *Successful* (10 Seconds to Populate Data) 
Ring Up JUUL Item – Scan Test ID – *Successful* (9 Seconds to Populate Data) 
Pull Up Customer Database – Scan Test ID – *Successful* (9 Seconds to Populate Data) 
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Code CR5215 

CODE CR5215 – Standalone Age Verification – Must use USB CR5215 with Sam4pos 
 Item #: 110405-U – USB scanner without power supply or DL Parsing file  

To Use a CR5215 With SAM4POS RACS\JUUL feature, a DL Parsing License Needs to Be Added: 
 Item#: 110410 – DL Parsing For Code Scanners 

USB Interface – Sam4POS 

When using a USB Interface with the Sam4POS registers scan the following Setup Barcodes:  
1. Scan to prepare reader for configuration.  

 
2. Scan to configure reader. 

 
3. For CR-5215 and CR-950 Integrated Age Verification scan 

M22444_01 A1 to Disable Standalone Age Verification. 

 

Some products may also have QR codes in close proximity to the UPC barcode making it difficult to scan just the 
barcode. It is possible to turn off / disable the scanners ability to scan a QR code.   

Be aware that if you decide to scan this code, you will not be able to scan any QR codes, this includes the QR 
codes used for programming the scanner.  

 

If QR Code reading is disabled, you can enable again by restoring the scanner to factory defaults, you will then 
need to reprogram the scanner as necessary and reload the DL Parsing file.  
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PLU Programming 

To use the JUUL feature you will need to setup PLU Status Groups for the different JUUL products. These PLU 
Status Groups will then be assigned to the corresponding PLUs for JUUL items. For reporting purposes, you may 
want to assign specific Groups to the JUUL items.  

 

PLU Status Group 
1. From the PROGRAM MODE touch PLU to view the PLU program selection window, touch PLU 

STATUS GROUP to view the PLU status group options. 

2. To enter a new status group into the database, press the Add New Item icon or, you can select an existing 
status group to copy by pressing and holding the status group. 

3. Type the descriptor in the INPUT DESCRIPTION field. 

4. Press OK to go on to the option programming. Press OK AND CONTINUE to add another PLU. Press 
CANCEL to cancel the new PLU entry. 

  

5. Scroll through the PLU Status Group options and program as necessary. The General option selections 
below are required for the JUUL feature. 

 

General 
NEED AGE VERIFICATION 

Enter the age for the restriction. The default Age for JUUL Products is 21. If the NEED AGE VERIFICATION 
value is set to a different value, the SAM4POS checks the data with this age for RACS system. If it is 0, the 
SAM4POS checks the data with the default age for RACS system.  

JUUL PRODUCT 
This option is specific for JUUL products. Customers must be at least 21 years of age to purchase. Each JUUL 
product will be assigned to a specific PLU Status Group for the product type.  
JUUL product type selections are: JUUL STARTER KIT, JUUL DEVICE KIT, JUUL 4-PACK REFILL KIT, 
JUUL 2-PACK REFILL KIT. The selection NONE, is used for all Non-JUUL products.  
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JUUL Product Type 

Quantities of JUUL product types sold within a transaction is limited, refer to the chart below.  

JUUL PRODUCT COUNTS 

JUUL STARTER KIT 1 DEVICE & 1 POD PACK 

JUUL DEVICE KIT 1 DEVICE 
JUUL 4-PACK REFILL KIT 1 POD PACK 

JUUL 2-PACK REFILL KIT 1 POD PACK 

 

The maximum count allowed in a single transaction is as follows:  
 DEVICE: 1 
 POD PACK: 4 

 

The SAM4POS checks the count when a JUUL Product PLU is selected for purchase. 

If the count is over the error message #182: IT EXCEEDS THE MAXIMUM NUMBER occurs.  

 

Group 
1. From the PROGRAM MODE touch PLU to view the PLU program selection window, touch GROUP to 

view the group programming options. 

2. To enter a new status group into the database, press the Add New Item icon or, you can select an existing 
group to copy by pressing and holding the on the desired group. 

3. Type the descriptor in the INPUT DESCRIPTION field. 

4. Press OK to go on to the option programming. Press OK AND CONTINUE to add another Group. 
Pressing CANCEL will exit without adding the group.  

 

PLU 
1. Go to: Program Mode →PLU →PLU  

2. Assign the appropriate Group Link1, 2, 3 as necessary for the JUUL items.  

3. Assign the appropriate PLU Status Group Link for the JUUL items.  
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Selling JUUL Products 

Selling JUUL products with the RACS feature requires the cashier to scan the customers Driver’s License to 
approve the sale of the product. With the RACS feature, JUUL products are limited to specific quantities allowed 
to be sold in a single transaction.  

 

 
You CANNOT use an age verification MACRO with the RACS\JUUL feature!  

1. From the Register Mode, Select or scan the JUUL product to be purchased. The notification dialog 
“NEED AGE VERIFICATION” displays and a continuous tone sounds until the customers age is 
verified.  

 

2. Scan the customer’s Driver’s License or,  
a. At the DATE OF BIRTH entry, Press EDIT button.  

Enter the birthdate for the customer from the customer’s ID\License  
b. At the EXPIRATION DATE entry, Press EDIT button.  

Enter the expiration date from the customer’s ID\License  

 

3. The age is verified; press ACCEPT to continue with the transaction. Pressing CANCEL will exit the sale 
of the JUUL product.  

4. Register additional products as desired, if more JUUL items are registered than what is allowed by RACS, 
the error message “IT EXCEEDS THE MAXIMUM NUMBER” displays.  
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Manual Entry 
1. If MANUAL ENTRY is chosen from the dialog “NEED AGE VERIFICATION”, the SELECT 

DOCUMENT TYPE notification displays.  

 

2. Choose the appropriate Document Type from the selections.  

 

3. Scan the customer’s Document or ID QR core or,  
a. At the DATE OF BIRTH entry, Press EDIT button.  

Enter the birthdate for the customer from the customer’s ID\License  
b. At the EXPIRATION DATE entry, Press EDIT button.  

Enter the expiration date from the customer’s ID\License  

 


